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Introduction 
GedStar is the program that fits your PC-based family tree information into your PalmOS  
handheld device so that you can easily browse it on your next research trip, or any time that you 
are away from your PC. There’s no need to take along all those printouts  just download your 
database to your handheld and use GedStar as your pocket genealogy reference. 

GedStar was previously known as “GedPalm,” but due to trademark restrictions and compliance 
with the developer program of Palm, Inc., the name was changed with the release of V4.0. 

The basic version of GedStar uses files for input on your PC that are in “GEDCOM” format. 
GEDCOM is a well-defined standard for genealogical information interchange. All popular family 
tree programs are capable of handling GEDCOM files for both input and output, so it will not be 
necessary for you to understand the contents of the GEDCOM file itself. 

There is also an upgraded version called GedStar-Plus that can convert data directly from the 
database of certain PC-based genealogy programs. There is no need to export data to a 
GEDCOM file. This makes the conversion easier to do and in some cases the data is more 
complete. V5.2 of GedStar-Plus supports data from Legacy Family Tree™ V4.0 and The 
Master Genealogist™ V4.0d and V5.0. 

GedStar is written to follow the general guidelines for PalmOS applications. One of these 
principles is that Palm programs should be easy to use and not require a lot of input from the 
user. In general, unless you have one of those detachable keyboard products, entering a lot of 
data on a handheld is a tedious chore. On top of that, genealogical data can be very complex, 
with numerous links between records that must be carefully maintained. Desktop PC programs 
are well-designed and well-suited for doing this, so the decision was made early on that GedStar 
would be strictly a data viewer, and not a data entry program. If you need to enter information 
while doing research, the combination of the “export to memo” feature and the built-in Memo 
Pad program can be used for taking notes for later entry on your PC. 

By writing GedStar as a “viewer” only, we are also able to use some special techniques for 
reducing the amount of Palm memory consumed by the database, and to optimize the program’s 
performance. A typical Palm III with 2 megabytes of memory can easily hold the basic information 
for several thousand individuals (depending, of course, on what other applications are loaded on 
the unit). 

Requirements 
GedStar consists of two components: the GedStar program itself that runs on the handheld, and 
a utility program that runs on your PC to convert a GEDCOM file to the database format required 
on the handheld. There is also a Hotsync conduit that can optionally be used for automatic 
updates from the PC to the Palm. The requirements for using GedStar are: 

• A handheld device that runs PalmOS V3.1 or later. This includes most of the devices 
available from Palm Computing, including specially branded units such as the IBM 
Workpad, all known Handspring products, the Sony Clie line, and others. GedStar has 
been tested up through PalmOS V5.0. 

• A PC running Windows 98/ME/XP/NT/2000. Windows 95 is no longer a supported platform. 

• A PC-based “family tree” program that can generate an output file in GEDCOM 5.5 format, or 
any other source that can generate a GEDCOM file. All popular genealogy programs for PCs 
have this capability. 

• For GedStar-Plus, a PC running V4.0 of Legacy Family Tree™ or The Master 
Genealogist™ V4.0 or V5.0. GedStar-Plus also continues to support GEDCOM files. 
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The Palm memory requirements for using GedStar are totally dependent on the size of the 
GEDCOM information. The GedStar program itself is about 100K bytes and the file converter 
makes numerous optimizations to minimize the size of the Palm database, but there is no getting 
around the necessity to store all of those names, places, dates, and so on. Typically the storage 
requirements on the Palm amount to about 100 bytes per individual, but this can vary depending 
on the length of names and places, the number of different names, etc. If you have a few hundred 
people in your family tree file, then the size of the GedStar database should not be a concern. On 
the other hand, if you have thousands of people, then you might want to consider exporting only a 
subset to the GEDCOM file or using one of the popular GEDCOM utility programs to “prune 
down” the size of the tree. Of course, if you have one of the new Palm devices with 8 megabytes 
or so of memory, then feel free to download as much as you would like to  GedStar can handle 
it if your handheld device can hold it!  

New in Version 5 
The following are the major new features in the Version 5 release of GedStar: 

• GedStar-Plus option for direct conversion from supported genealogy databases. 
• Pop-up “pick list” for quickly selecting a new focus person from any major view. 
• Easy bookmark setup using the pick-list. 
• Browser-style back and forward controls on major views to let you go back and forth through 

your view history. 
• A relationship calculator. 
• Rearranged menus for better access to most-used features. 
• Special support for the 5-way navigation control on Palm Tungsten-T™ devices 
• Special support for the Jog Dial™ on Sony Clie™ devices. 

Updates in 5.2 
• Supports hi-res 320x480 expanded screen mode on certain models of the PalmOne 

Tungsten, Sony Clie, and Garmin iQue. 

Updates in 5.1 
• GedStar-Plus now supports The Master Genealogist using GenBridge technology from 

Wholly Genes, Inc. 
• Added filtering support to Legacy Family Tree using tag options. A subset of the individuals 

in a database may be exported. 
• Improved progress dialog; conversion application repaints and is more responsive during the 

conversion process. 
• Minor fixes to the PalmOS application portion of GedStar. 

Quick-Start Operation  
Detailed operational instructions are presented later in this manual, but the following summarizes 
the operation of GedStar: 

1. Use your family tree program on your PC to generate a GEDCOM file (you can skip this step 
if using GedStar-Plus.) 

2. Run the GedStar or GedStar-Plus program on the PC to convert the GEDCOM file to a 
GedStar database file (file with a “.pdb” type extension). You have the option of selecting 
how much extra information will go into the database. If using GedStar-Plus, you can directly 
select your genealogy database file. 

GedStar & GedStar-Plus V5.2 User’s Guide 5 GHCS Software 



3. HotSync your device. 

Alternatively, you can use the HotSync Conduit feature for automatic updates (GEDCOM only): 

1. Run the Configure Conduit program to activate and configure the conduit (you only have to 
do this once). 

2. Generate your GEDCOM file if necessary. 

3. HotSync your device. 

With this method, any time you repeat step (2) to create a new version of your GEDCOM file, the 
GedStar database will automatically be generated and downloaded during your next HotSync. 

After the HotSync, you can run GedStar on the handheld and see the list of names from your 
genealogy database. Starting from the basic List Screen, you can do the following: 

• Select an individual to see their Family Screen that shows their spouse, marriage information, 
and children. 

• If an individual has multiple spouses, you can select another spouse from the list and bring 
up that Family Screen. 

• Go from an individual’s Family Screen directly to that of their parents, or to the Family Screen 
of one of their children by a single tap. 

• Tap on an individual on their Family Screen and get a Details Screen that will show you all of 
the information in the database for that person. A popup list is used to choose what will be 
shown. 

• Use the “Export” menu selection to copy data to a Palm memo record. 

• Return at any time to the List Screen to select an individual by name. 

• Use lots more tools and features. Play with the program or (preferably) read the section of 
this manual that deals with Using GedStar. 

GEDCOM Support 
GedStar makes no attempt to support the entire contents of the GEDCOM file on the Palm 
device; the entire idea is efficiency and conciseness. The following are the supported tags and 
information types: 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Birth, christening, death, and burial events (BIRT, CHR, BAPM, DEAT, BURI). This includes 
dates and places (DATE and PLAC) if specified. BAPM and CHR are considered equivalent 
events. 

A single alias name (ALIA). 

Notes (NOTE) that are directly associated with the individual or with a marriage/family, as 
well as notes associated with major events (BIRT, MARR, DEAT, BURI). 

Titles (TITL). 

LDS Ordination (BAPL, ENDL, CONL, SLGC, SLGS). 

Reference tags (REFN) for individuals. 

Source tags (SOUR) for major facts and events. Within a source record, additional 
description tags are supported (AUTH, PUBL, TEXT). 

Source citation tags for major facts and events (PAGE, EVEN, ROLE, DATA, TEXT). 

Character coding (CHAR ANSI) for standard character sets, CHAR ANSEL for international 
(European) characters. 
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Other tags may be supported in the future, depending on demand. The above should cover most 
of what people typically use in a genealogy program. 

GedStar-Plus Support 
GedStar-Plus continues to support the same information that is supported in the GEDCOM 
version of the product. Since most genealogy programs have more information than can be 
expressed in the GEDCOM standard, this may change in the future. However, some information 
is presented in a more accurate way, such as dates and notes, due to the direct extraction by the 
GedStar-Plus converter. 

Support for European Characters 
GedStar supports all European (accented) characters that are also supported in the standard 
PalmOS character set, but only if they are represented in the GEDCOM file by using ANSEL 
coding. That is, the tag “CHAR ANSEL” must appear in the header section of the GEDCOM file. 
In most cases, support for ANSEL coding should be built into your PC-based genealogy software, 
and may be an option that can be set in the program preferences, or when performing the export-
to-GEDCOM operation. 

If the ANSEL option is not declared in the GEDCOM file, the conversion programs simply copy 
whatever characters are in the GEDCOM file to the PalmOS databases. Any characters that are 
not in the normal ASCII character range (‘A’-‘Z’ and ‘a’-‘z’) are copied as-is to the Palm database. 
These character codes will probably not display correctly when shown on the handheld’s screen. 

License 
The official license details are in the License.txt file in the GedStar installation directory. 
However, the following is a brief summary: When you license GedStar, you can enter the 
registration password in all copies of GedStar that are running on PalmOS devices that are 
owned within your household. In other words, the registration is a sort of “site license” that applies 
to your household. 
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Installation 

Upgrading From a Previous Version 
If you are upgrading from any previous version of GedStar, you must first uninstall the desktop 
GedStar package from your PC. To do this, open the Control Panel (from the Start Menu | 
Settings selection). Double-click the Add/Remove Programs icon. Select GedStar from the list 
and click on the Add/Remove button.  

You should not delete an earlier GedStar version from your Palm device. Just install the new 
version over the previous version. Note that, when installing a new version on your PalmOS 
device, you should always regenerate your database files and download them at the same time. 
This version of GedStar will automatically recognize any earlier installed databases and will 
delete them the first time it is run. This is necessary due to the change in database format from 
the previous versions of the product. 

Note: If you are using the older GedPalm program, then it is necessary for you to delete the 
application from your handheld before installing GedStar. Due to the name change, the launcher 
can become confused if both GedStar and GedPalm are installed at the same time. 

GedStar vs. GedStar-Plus 
GedStar-Plus is an enhanced version of GedStar that has the capability of converting data 
directly from certain PC genealogy program databases. This package comes with a new 
conversion program, and you should uninstall any existing GedStar software from your PC before 
installing GedStar-Plus. This is true even if you are upgrading from GedStar V5.0 to GedStar-
Plus V5.2. The GedStar-Plus converter converts GEDCOM files as well as the directly supported 
databases, so you will not lose any of your original capabilities. 

Installing Files on the PC 
GedStar is distributed as a self-extracting executable program that uses a popular and familiar 
product installation tool. After downloading the GedStar5.exe file to a folder on your hard drive, 
simply double-click on it an Explorer window and the installation will proceed. After the installation 
procedure finishes, you have to Hotsync your device in order to load the GedStar PalmOS 
application onto it. 

The installation procedure creates a GedStar program group under Programs on your Start 
menu. Be sure to read the ReadMe file, which is accessible from the menu. 

Installation on the Handheld Device 
The GedStar program is installed on your handheld device during the installation procedure and 
will show up in the application launcher. However, if you run it without installing the database files 
you will get an error message saying that there are no databases loaded. Before you can use 
GedStar, you will have to generate and install your genealogy database. 

If you want to install the application on another handheld, or if you delete GedStar from your 
device and later want to re-install it, just find the GedStar50.prc file in the installation directory 
(C:\Program Files\GedStar by default) and double-click on it. This will bring up the Install Tool, 
and you can select a device on which to load it. 
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Registration 
In order to continue using GedStar after the free demo period (currently 45 days), you must 
purchase a registration password and enter it into the registration dialog box on your handheld. 
For information on registration, go to the web site from which you originally downloaded the 
product. The URL for this site is also shown in the registration dialog box in the handheld 
GedStar application. 

If you are a registered user of GedStar and wish to upgrade to GedStar-Plus, an upgrade 
password is also available for a nominal fee. 

Uninstalling 
We hope that you do not have to uninstall GedStar, but if you do it is just a standard procedure. 
On your handheld device, of course, you can delete it from the menu in the application launcher. 
On your PC, open the Control Panel (from the Start Menu | Settings selection). Double-click the 
Add/Remove Programs icon. Select GHCS Software GedStar from the list and click on the 
Add/Remove button. 

Any GEDCOM and converted database files will not be deleted by the uninstall process. You will 
have to clean up and delete the folder itself manually. 
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Converting a GEDCOM File (GedStar) 
Before being able to start browsing on your handheld device, you need to convert a GEDCOM file 
to the Palm database format that is used by GedStar. There are basically two ways to do this: 
use the GPConvert program (described below), or use the GedSync Conduit (described in the 
next chapter). 

Preliminary Steps 
As a first step, you may have to generate the GEDCOM file itself by using one of the features of 
your genealogy program. The method for doing this varies depending on your program, but it is 
probably found somewhere under the File menu – possibly a selection labeled Export. Consult 
your product’s manual or on-line help for instructions. The output of this operation should be a file 
with a type (file extension) of “.ged”. If available, select options for “GEDCOM 5.5”, “Abbreviated 
tags”, and “ANSEL” encoding. You can save the GEDCOM file in any directory on any disk drive 
on your PC. 

Running GedStar 
 

Assuming that you chose the default start menu folder when installing, start the conversion 
program by clicking on Start -> Programs -> GedStar -> GedStar. The following window should 
appear: 
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At this point, you can enter the GEDCOM file name or use the Browse button to locate it. There 
is also an option for Multiple Databases that you can select. If you select this, then you can 
specify a name for the database in the text box. This name is what will be displayed in the 
GedStar database management screen. It will also be used as the name of the database file that 
is generated by the program. In other words, a database name of “Demo” will generate a 
database file named “Demo.pdb.” The name should contain only printable characters and spaces, 
and be no more than 16 characters long. 

The following options can be selected: 

• Include General Notes – Include notes for individuals and family units that are found in the 
file. The main reason to not take this option is to save space on your device. 

• Include Event Notes – Include notes for major events, such as birth, marriage, death, and 
burial. This is for genealogy programs that let you attach notes or memos to events as well as 
to individuals as a whole. 

• Unlimited Note Length – If this is not selected, space is saved by limiting the length of notes 
to 1024 characters. When selected, the full text of all notes is included, up to 32K characters. 

• Line-breaks in Notes – This option attempts to preserve the original note formatting by 
starting note continuation lines on a new line of the display field. Otherwise, the note is 
treated just as a continuous piece of text. 

• Concatenate with space – This option is necessary due to the different ways that genealogy 
programs use the CONC tag. If you look at some of your longer notes in GedStar on your 
handheld and see that there are some words that are run together without a space between 
them, then you should check this option. On the other hand, if you see some words that have 
a space in the middle of the word where it does not belong, then make sure that this option is 
unchecked. This option does not apply to GedStar-Plus since notes are taken directly from 
your database. 

• REFN Tags – These tags are used for the unique identification of individuals in the database. 
Your GEDCOM file may not have them depending on options that you have selected in your 
PC genealogy program. Including these tags in the GedStar database can cause an increase 
in its size; on the other hand, it may be useful for you to see these strings in the GedStar 
display and be able to search on them. 

• Sources – There are three options. If you choose No sources, then sources will not be 
included in the database and you will not be able to view them on your device. The Full title 
or Abbreviated title options will cause sources to be included. The difference is whether the 
database will include the full title of the source as contained in the TITL tag in the source 
record, or if the shorter text in the ABBR tag will be used. Regardless of the selection, if a 
source record only has one of these two tags specified then that is the text that will be 
included. In other words, if you select Full title, but a source record only has the abbreviated 
title text, then that is the text that will be used. 

• Include source details – This option causes GedStar to include most of the information 
from the source records, including things like the author, publisher, and possibly the actual 
text of the source. Again, what gets included depends on how your genealogy program 
supports source records in the GEDCOM file. 

• Include citation details – This causes additional information from the specific source 
citations to be included. This can be things like the page number, text extracted from the 
source, etc. If you use sources heavily, then checking this and the above option can cause a 
lot of additional text to be included in your database. 

When you press the Convert button, a progress window will be shown and the conversion 
process will start. When complete, a dialog box shows the final conversion status and also offers 
you a chance to view the conversion log file. The log file shows various statistics about the 
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conversion operation and also may contain error details if the conversion failed. The log file is 
actually stored in your GedStar home directory with the name GPConvert.log. 

If the conversion was successful, the conversion program schedules the database for 
downloading to your handheld by launching the standard Install Tool that came with your device’s 
desktop software (e.g., Palm Desktop for most Palm-branded devices). Depending on the version 
of the desktop software installed on your PC, the window and options available will be slightly 
different. The following shows the installation dialog from Palm Desktop 4.0: 

 

You should now be able to run GedStar on your handheld device and immediately see the 
master list of individuals from your GEDCOM file! A later chapter provides details of GedStar’s 
operation. If you are loading a database with a different name from the one that GedStar was 
previously using, you will have to go to the database management screen (page 25) to select it 
for viewing.  

Installing to a Removable Memory Card 
If you have a device that supports add-in memory cards, such as the Palm M500, the Install 
Tool will give you the option of installing the database to the memory card instead of to the 
handheld’s internal memory (the Change Destination button in the above dialog). This feature is 
now fully supported by GedStar, so you can install your databases to a removable card instead of 
taking up your limited device memory. 

For some types of add-in cards, it is possible that your PC has an adapter of some sort that lets 
you drag-and-drop files directly to a memory card instead of accessing it through the Hotsync 
process. If you want to copy files directly from your PC to such a device, you must make sure that 
you put the GedStar databases into a directory on the card that is named “\PALM\Launcher”. 
This is the directory used by the Install Tool and is where GedStar always looks to locate its 
databases. 
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Manually Loading the Database 
If you examine the C:\GedStar folder with Windows Explorer, you should see the Palm database 
files that were created by GPConvert. This file will be named either Default.pdb, or whatever 
name was specified in the Database Name box. If you did not take the automatic install option, 
then this file must be selected to be loaded on your next HotSync operation. 

1. Using the Install button from the Palm Desktop program, browse to the GedStar folder and 
select the database file for installation.  

2. Put your Handheld in its cradle and perform a HotSync. Warning: these databases can be 
quite large if you have a lot of people in them, so it may take a few minutes to download to 
the Palm unit. 

Conversion Errors 
Although the program has been tested with a variety of GEDCOM files, there is always the 
possibility that a particular file will contain information that GPConvert can not handle properly. 
There is a file named GPConvert.log that is created in your GedStar directory whenever you run 
a conversion. 

In a case where you do not see the “conversion successful” message, do not attempt to load the 
database file onto your Handheld; corrupted database files can cause GedStar to terminate 
abnormally. Instead, please send an e-mail message to the author’s address. Attach the 
GPConvert.log file. Do not send your GEDCOM file unless we respond to you and request it. 

Some common conversion problems that people have encountered include the following: 

• If you are using PAF 5 or later, make sure that “ANSEL” is selected for the GEDCOM 
encoding option. The default for PAF 5 is a format that cannot be handled by GedStar. 

• Make sure that you use “Abbreviated tags” for the GEDCOM file. 
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GedStar-Plus Direct Conversion 
GedStar-Plus differs from the basic version in being able to convert data directly from the PC 
genealogy program’s database without having to go through a GEDCOM export procedure. In 
addition to the added convenience, the data may be more complete because the GEDCOM 
export procedure does not always export all of the information. 

Running GedStar-Plus 
To run GedStar-Plus, use the Windows Start Menu, selecting Start -> Programs -> GedStar -> 
GedStar-Plus. The following window will appear: 

 

 
 

This is very similar to the standard GedStar window and the options are the same as explained in 
the previous section. The main difference is the choice of file types that are available when you 
click on the Browse button, thus: 
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Note that the dropdown list allows you to select databases from Legacy Family Tree and The 
Master Genealogist as well as GEDCOM files. After selecting your database, the rest of the 
conversion process is identical to the basic GedStar product. 

One additional option is accessed via the Filters button. This allows you to select a subset of the 
total number of individuals in your database. For Legacy Family Tree, individuals can be 
selected based on the tagging feature of that program. You can include any combination of 
people with tags 1 through 9 applied. For The Master Genealogist, you can filter people based 
on their dataset. A project file can contain multiple datasets, and you can choose to include one 
or more of the datasets. If the No Filters Active text appears in the main window, it means that 
all the people in your database will be included. 

Legacy Family Tree is available from http://www.legacyfamilytree.com. There is a free version 
available for trial on their web site, and GedStar-Plus may also be purchased there. 

The Master Genealogist  is available from http://www.whollygenes.com. The processing of TMG 
databases is made possible by use of the GenBridge technology, licensed by Wholly Genes, Inc. 
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The GedSync Conduit 
GedSync is the name given to the overall HotSync conduit package provided for the GedStar 
Pilot genealogy viewing application. This is an optional component that may not be suitable for 
everyone’s usage. If you are happy with the use of the GPConvert program to occasionally 
generate the GedStar database files, then you may not need to use GedSync. However, there 
are some advantages to using the conduit, including the following: 

• 

• 

• 

• 

The conversion of the GEDCOM file takes place automatically during a HotSync operation. 

The converted data is downloaded directly to your Pilot; there is no need to explicitly install 
the database files that are produced by the manual conversion program. 

Whenever you update your GEDCOM file or create a new copy of it, it will be automatically 
converted and downloaded to your Pilot during your next HotSync operation. 

The GEDCOM file and options are configured for a specific Palm device according to the 
Palm’s “user name.” Multiple people can HotSync with the same PC, but with different 
GEDCOM files. 

The conduit is only supported on Windows 98, NT, 2000 and XP systems, and with Palm 
HotSync V3.0 or later software. There is no conduit currently supported for GedStar-Plus. 
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Running GedSync 
All conduit control and configuration operations are done using the GedSync utility. To run this, 
select Start -> Programs -> GedStar -> GedStar Conduit from the menubar. If your PC 
supports multiple Palm users, you will first see a window with a dropdown box from which you 
must select a specific name. After this step, the following window should appear:  

 

Conduit Control 
In order for the GedSync conduit to be used, it must be “registered” with the HotSync program. 
The status of the conduit is shown in the Conduit Control section of the window, and the button 
will show either Activate or Deactivate accordingly. 

If you want to start using GedStar with the conduit instead of the manual database generator, 
click on the Activate button. If you are already using the conduit, but want to stop using it, click 
on Deactivate. If the HotSync program is running at the time that you choose either of these 
options, it is necessary to restart it in order for your changes to take effect. A dialog box appears 
that gives you the option to restart HotSync. You should normally select Yes. 

Note for multi-user systems: On multi-user systems, it is necessary to activate the conduit 
separately for each logged-in user who runs HotSync. This is true for all Palm conduits, as the 
applicable registry keys are stored under the “CURRENT_USER” key. 
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Conduit Configuration 
The conduit must be configured with the name of a GEDCOM file and all appropriate conversion 
options. This section of the GedSync window looks and works exactly like the GPConvert utility 
that was described in the previous chapter. See that section for descriptions of the conversion 
options. You must select OK to write your selections to the registry where the conduit can find 
them. 

Note: The conduit can only synchronize one database at a time. If you have multiple databases 
and also want to use the conduit, you will have to run GedSync to specify one GEDCOM file at a 
time and HotSync it.  

HotSync Conduit Options 
HotSync supports several action options that can be set for each individual conduit. GedSync 
supports these options where they are applicable. To see these options, you can click on the 
HotSync icon in the tray and then select Custom from the menu. You will see the current settings 
for all of the conduits that are installed on your system.  

The default conduit action for GedStar, as for most other conduits, is “Synchronize the files.” With 
this setting, the conduit will convert and update your Palm genealogy database whenever the 
configured GEDCOM file is updated, or when other changes are made to the GedSync settings 
on the PC. This is the way that the conduit should normally be set. 

However, if you select GedStar and then click on the Change button, you can see all of the 
possible choices. These are: 

Synchronize the files - As described above. The normal mode of operation. • 

• 

• 

• 

Desktop overwrites handheld - Forces a conversion and download of the GEDCOM file 
data, regardless of what is already on the Palm. This might be useful to force a one-time 
update of your unit, but it should not be selected as the default action. 

Handheld overwrites desktop - Meaningless for GedStar. Will result in the conduit doing 
nothing. 

Do nothing - Bypasses the conduit’s actions. Useful if you do not want to take the time for a 
conversion operation. 
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Conduit Operation 
The conduit runs as part of a normal HotSync operation. Since the conversion and download of a 
large genealogy database is a rather time-consuming operation, the conduit displays a special 
progress status box whenever a conversion is necessary. This includes short status messages 
and a progress bar. 

At the end of a HotSync operation where a new database was downloaded, there may be an 
additional lengthy operation while the Palm databases are backed up. This will definitely occur if 
you are using BackupBuddy or other 3rd-party backup software. However, this does make 
device restoration more reliable. 

There are two places where you can look to check the operation of the GedStar conduit and view 
its results. 

HotSync Log. Clicking on the HotSync icon in the system tray, you can select the View Log 
item. This brings up the log maintained by HotSync itself. The conduit, using the name GedSync, 
may make entries in this log that indicate why or why it did not do a conversion. This is the first 
place to look to see if the conduit is operating normally. 

Conversion Log. The conversion module produces a detailed log file that may be of some 
interest, and may also contain valuable error information if there is a problem with converting the 
file or accessing the Palm device. This log file, named GedSync.log, will be found in the GedStar 
folder under your Palm user’s directory. If you go to your Palm Desktop folder, usually C:\Palm, 
you will find a folder for each configured Palm user. In this folder, there will be a GedStar folder, 
which is where the conduit stores its specific files. The log file is found there. 
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Using GedStar on PalmOS 
After installation of GedStar and its databases, you should find an icon in the launcher screen 
and be able to start the program. If there are no error messages, the first screen you will see is 
the List View. For “tips” (help) in any view, tap on the “i” button in the lower right corner. 

Registration and Upgrade 
When you purchase GedStar or GedStar-Plus from the site from which you downloaded it, you 
will receive an e-mail message or web page containing a registration password. This must be 
entered into GedStar in order to unlock all of the program’s features. The following are the steps 
to follow to accomplish this: 

1. With GedStar running, bring up the menu bar by tapping on the menu icon in the lower left 
corner of the graffiti area on your device. 

2. Tap on Options to bring down the menu list if it is not already showing, then tap on About 
GedStar. 

3. If your copy is not registered, a Register button will be visible; tap on this button. 

4. In the next dialog box that pops up, enter the registration password that was sent to you, then 
tap on OK to complete the registration process. 

If you are already a registered user of GedStar and are upgrading to GedStar-Plus, you will see 
an Upgrade button on the About GedStar screen. Tap this to enter your upgrade password. 

Once this is done, you will not have to re-register the program unless you delete it from your 
device and then re-install it. If you download an update to GedStar, just install the new version on 
your device without deleting the previous version. The updated version will continue to be 
registered and you will not have to repeat this process. 

List View 
This view is an alphabetic listing of everyone in the database. To 
help distinguish people with identical names, the person's lifespan 
years are shown in the right-hand column. In some cases, neither 
date is known. 

The small square dot to the left of the year, if present, indicates 
that this person has one or more descendants in the database. 
This is especially helpful when searching down along a family 
line. On a color device, the names are color coded to indicate if 
they have descendants or not. This indicator can be turned on 
and off through the Preferences settings. 

There are four ways to navigate within this list, plus a search feature: 

• 

• 

• 

The scrollbar can be used by clicking above or below the slider, or by simply dragging the 
slider. The list scrolls as you drag, helping to see where you are. 

The scrolling hardkey on the handheld can be used to scroll up or down one page at a time. 

Use graffiti strokes to enter characters in the Lookup field. See below for a description of how 
this works. 
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• If your device has a special navigation control, it may also be used to scroll through the list 
and make a selection. 

When you locate a person of interest, tapping on their name takes you to the Family View 
screen. If you tap on the year (or in the place where the year would be), you will go directly to the 
Details View screen. 

The arrows at the bottom right are browser-style back and forward controls that let you navigate 
through your view history. 

Lookup Field 
The Lookup field lets you quickly scroll the list to or near a name of interest. To use it, just start 
entering characters using the Graffiti area. As you enter characters, GedStar scrolls the list to the 
first person whose surname starts with the letters entered so far. This is similar to the way that 
the built-in Address Book works. What is more, if you enter a comma (“,”) and then start entering 
more characters, the list scrolls to the first person whose surname and given name start with the 
characters entered so far. For example, the string “da,th” might match a person named “Davis, 
Thomas” in the list. 

If you delete characters (by entering the backspace stroke), the list is repositioned accordingly. If 
you enter a character and hear a “beep” (and the character does not echo on the line), it means 
that there was no match for the new string. The lookup string is cleared whenever you actually 
tap on a person in the list, or move the list by using the scroll buttons, etc.  

Searching 
Tapping the Srch button brings up a dialog box where you can 
specify full or partial strings for a surname, given name, or both. 
The string matching is slightly different for these strings. The 
surname search always tries to match the string starting at the 
beginning of the name. For example, the search string “wil” would 
match “Williams” and “Wilhelm,” but not “Burwill.” The given name 
string, on the other hand, will match if it appears anywhere within 
the person’s name. The string “ric” would match “Richard” and also 
“Cedric.” 

Tapping the Search button in the dialog performs the search, 
always from the top of the list. After you return to the List View, 
tapping Next will take you to the next person that matches the most recent search string(s). Also 
in the Search Dialog are the Cancel button to exit from the dialog without searching, and the 
Clear button to erase the search string fields. 

The Soundex option will help to search for surnames that have spelling variations. This method 
of coding a name is based on a well-known standard that is used by various U.S. government 
agencies as well as genealogy researchers. For example, when using the Soundex option, a 
search for the surname “Shaffer” will also match a variation such as “Schaefer.” This may be 
useful if you have families whose names have changed over time or in different locales. 

If you enter a string on the REFN line, then the REFN "reference tag" strings will be searched for 
an exact match. This of course assumes that your are using REFN tags in your database and that 
the corresponding conversion option was selected. Note that this search may take a very long 
time within a large database. 

The Index number line allows you to search for a person with a specific database index number 
(the entry here must always be numeric). Normally you would not be expected to know this 
number, but some genealogy programs generate their GEDCOM files using the same individual 
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identification number as used in the PC database. In this case, you may know this number and 
can go directly to the individual. This search, unlike the REFN search, is very quick. 

If you use the REFN or Index searches, make sure to clear all the other lines in this dialog. The 
search will generally use whichever line it first sees that contains data when deciding which type 
of search to perform. 

Database Selection 
On the top line of the list view is the name of the current database that you are using. If you are 
using a single database, this will probably just read Default and you will not have to do anything 
more with it. If you have multiple database loaded, then tapping on this will bring up a list of 
installed databases. Tap on any of them to switch databases. This is decidedly quicker than going 
to the Database Management view. 

If you have a handheld device with a removable memory card, such as a Palm M500, and 
there are GedStar databases installed on the card, these databases are noted on the list with a 
distinctive memory card icon next to them. Accessing these databases is no different from any 
other database. 

Family View 
Depending on the information available for the selected person, and their spouse if any, the 
Family View may contain a variety of visible information and fields. For example: 

 

The selected individual and spouse are in the top section of the screen, with full birth and death 
dates shown. The middle section has information on their marriage: date and place if known. At 
the bottom is a scrolling list of their children. This list can be scrolled with the scrollbar or scroll 
buttons. Pressing the (Lst) button returns you to the List View. The “F” number is the index 
number of the family record in the GEDCOM file. 

The following actions will occur depending on where you tap on the screen: 

Tapping on one of the children’s names takes you to the Family View for that person. Or, tap 
on the year column to go directly to the Details View. 

• 

• 

• 

Tapping on the name of the primary person or spouse takes you to the Details View for that 
person, from which you can return to this screen. The Details View includes expanded 
information on birth and death events, if known, and may also include notes and other 
information. 

If the (P) button is visible, it indicates that the person’s parents are in the database. Tapping 
the button takes you to the parents’ Family View. In other words, you will see a Family View 
on which the selected person is shown as a child. 
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• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
• 
• 
• 
• 
• 
• 

If the (S) button is visible, it indicates that the person has more than one spouse. If you tap 
this button, you will see a popup list containing all the spouses’ names. If you select a 
different one, you will then go the Family View for the selected person and the new spouse. 

If the note icon is showing (as in the upper right corner of the example above), it indicates 
that there is a note record for that person in the Details View. Tapping on this icon or on the 
person’s name takes you to that view with the note displayed in the text area. 

The up-arrow icon takes you to the Ancestors Tree View and the down-arrow brings up the 
Descendants Tree View. These are described in a later section. 

The note icon in the marriage section, if present, brings up a window showing notes that are 
associated with this family record. 

The (Sour) button, if visible, brings up a popup that shows what events have source 
information available. To display the specific source details, tap on one of these entries. If 
there are no sources, then this button is not shown. 

In some cases, the information in this view may appear truncated simply because of the 
limited width of the screen. To view the rest of the line, tap on the truncated field and it will 
scroll across. Tap again to keep scrolling or to return to the beginning of the line. 

The (Srch) and (Nxt) buttons work the same way that they do in the List View, except that 
they take you to the Family View of the person that is found. 

The (Sel) button brings up a pick list that looks and works very much like the List View 
screen. This lets you select a new individual and return to the Family View for that person. 

The back and forward controls in the lower right corner let you navigate through the views. 

If your device has a special navigation control, it can be used in this view to scroll through 
and select individuals. 

If you bring up the menu, you can select Export to Memo from the Tools menu to export the 
complete family group information to a standard Palm memo. You are also given an option to 
view the data and/or edit it. The memo will then be transferred to your Palm Desktop or other PIM 
during the next HotSync. It can also be viewed and edited from the built-in Palm MemoPad 
application. 

Details View 
This view shows as much information as possible about a person, 
without any truncation of the text (except in extreme cases). 

At the top is the person’s full name. The “I” number is the index 
number of the individual’s record in the GEDCOM file. If a REFN 
tag is specified, that is shown instead of the index number. Most of 
the remainder of the screen is used for a scrolling text field to 
contain the selected information. The list popup can be used to 
select the available information, which is then displayed in the field. 
This information can include: 

Birth/death dates and places 
Christening and burial dates and places 
Title (Dr., Sir, etc.) 
Alias name (aka) 
LDS Ordination events 
Notes 
-All Info- 
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Of course, the presence of this information depends on the individual as well as the conversion 
options that were selected. Tapping the (Fam) button returns you to the previous Family View 

screen, while tapping (List) takes you back to the main list view. If 
shown, tapping the (Par) button takes you to the Family View of the 
person’s parents. In other words, it goes to the family in which this 
person is listed as a child. 

The (Sour) button, if visible, brings up a popup that shows what 
source information is available. This includes sources for the person 
as a whole, plus for major facts and events such as birth, marriage, 
death, burial, and notes. To display a text window with the source 
details, tap on one of these entries. The amount of information that is 
displayed is dependent on the options that you selected when 
converting your database. 

The (Search) and (Next) buttons work the same way that they do in the List View except that 
they take you directly to the Details View of the person that is found. The (Parents) button takes 
you to the Family View for the person’s parents, while (Family) goes to the Family View for the 
current person. The (Select) button brings up the pick list that can be used to select another 
person in the current view. 

If you bring up the menu bar, you can select Export to Memo from the Tools menu to export the 
person’s complete information to a standard Palm memo. You are also given an option to view 
the data and/or edit it so that you can enter research notes, etc. The memo will then be 
transferred to your Palm Desktop or other PIM during the next HotSync. It can also be viewed 
and edited from the built-in Palm MemoPad application. 

The “-All Info-“ selection is “sticky” in that once you select it, it becomes the default for any other 
Detail View that you bring up during the same session. This option displays all facts, events, and 
sources that are available for the selected person. 
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Ancestor and Descendant Tree Views 
These views are initiated by tapping on the arrow icons next to the individuals in the Family 
View. In each view, the “root” individual is shown at the left margin of the screen, with each 
generation indented from the preceding generation by dashes. A person’s spouse is indented at 
the same level and preceded by a “+” character. When one of these views is active, the following 
can be done: 

• Tapping on a person's name redraws the view with that person as the new “root”. Thus you 
can navigate up or down along a line of descent. 

• Tapping the back-arrow icon (when shown) takes you back to the previous tree view. This 
lets you go back and forth along a given line. 

• A tap on the date column takes you to the Family View for that person. This is one way to 
exit from the tree views. 

• The Done button returns you to the original Family View from which the tree view was 
initiated. 

Bookmarks 
This feature provides a quick way to jump to the information for a 
particular person of interest. Up to eight (8) bookmarks per 
database can be defined. The bookmarks remain available until 
the database is deleted or until a new version of the database is 
downloaded. To manage the bookmarks, tap on the menu icon, 
then on Tools, and then Bookmarks. “Shortcut-B” can also be 
used. 

The Current Selection field shows the person that was active when 
you came to this screen. To add this person to your bookmarks, 
tap on the Add pushbutton, then tap on a bookmark slot (if you tap 
on a slot that already has a name in it, that name will be replaced 
after you get a confirming dialog). You can also remove an entry by using the Delete pushbutton. 
The default action is to use the Go to pushbutton to select a name from one of the slots. This 
takes you to the Family View for that person. 

Another quick way to fill in bookmarks is to select the Add pushbutton and then tap on any of the 
slots. This brings up the pick list from which you may select a person to insert in that slot. 

There is also a more direct way to get to bookmarked people without having to bring up this view. 
From almost any view, you can enter a bookmark slot number (1 – 8) in the numeric graffiti area 
and you will jump right to that person’s data while staying in the current view. This is the quickest 
and easiest way to use bookmarks. If you are in the List View, you can make this jump by 
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entering the shortcut stroke followed by the bookmark number (the shortcut stroke is a diagonal 
slash from lower left to upper right). This shortcut jump will also work in any of the other views. 

On This Day 
This feature is available from the Tools menu in any view. It shows 
the births, deaths, and/or marriages that are in your database for a 
given month and day – usually the current date. To select which 
events are searched for this display, use the  
option. By default the current date is selected, but you have the 
option of choosing any date on the calendar if you so desire. 

Setting Preferences

The year of the event is shown after the name(s). The number in 
parentheses is the number of years since the event. For example, 
in the screen shown at the right, 23 Feb 2002 is the 212th 
anniversary for Alburtis and Hannah Ringo. 

Note: This feature requires searching your entire database. If your database is large, and 
especially if it is on an add-in memory card, it can take a long time to finish. A tap on the screen 
cancels the search. 

Soundex Calculator 
Soundex codes are used in census listings and other types of 
records as a way of identifying people whose names sound the 
same, or are otherwise related, but are spelled differently. 
Genealogists often use these codes to account for the variations in 
the ways that different branches of a family spell their surnames. 
The GedStar search facility allows you to search using Soundex 
codes, but there is also a Soundex calculator dialog that can be 
accessed from any view by selecting the Tools menu (tap the menu 
icon in the lower left of the graffiti area to display the menu bar). 

To use it, enter a surname in the Name field and then tap the (Calc) 
button. The Soundex code will appear as shown (it is always a letter 
followed by three numeric digits). Tap (Clear) if you want to clear the current name and enter 
another one. 

Relationship Calculator 
This feature is available from the Tools menu in any view (tap the 
menu icon in the lower left of the graffiti area to display the menu 
bar). The name at the bottom is the reference person for the 
calculations. Tap on the name to bring up the pick list and select a 
new person. This setting is saved until you change it again. The 
name at the top is usually the name of the last person that you were 
viewing. You can also change this name by tapping on it and making 
a selection. 

The Search limit buttons limit the number of generations to search 
back on. The 99 selection means “search as far back as possible.” 
This option is for performance reasons when searching a very large 

database. 

When you tap on (Calc), the program calculates the closest blood relationship that the first 
person has to the second person. Due to the constraints on handheld processing power and the 

GedStar & GedStar-Plus V5.2 User’s Guide 26 GHCS Software 



potential complexity of some family trees, GedStar does not search relationships by marriage or 
for additional, more remote relationships. 

You may calculate as many relationships as you want, tapping (Done) to return to your previous 
view. 

Database Management View 
You can get to this view by tapping on the menu button in the 
lower left of the graffiti area, tapping on Options, and selecting 
Databases. This is the view that you use to select a different 
database, or to delete a database that you no longer need to have 
on your device. For each database found on the device, this view 
shows the database name (the name that you selected in the 
conversion utility), the number of people in the database, and its 
Palm memory usage in binary kilobytes (1024 bytes per kilobyte). 
The name in bold is the database that you were most recently 
viewing. 

A small “memory card” icon is shown next to any databases that are found on an inserted 
memory card (such as an SD card on a Palm M500). Note the “Scotland” database in the 
screen at the right. 

The way this view works is that you first select a “mode” or “action” from the button bar along the 
bottom of the screen. Next, you tap on a database name to perform the selected action. The 
following are the actions: 

• Select – Selects the database for viewing and goes to the initial List View screen. This is the 
only way to exit from the Database Management view. 

• Delete – Deletes the database from Palm memory (or from a memory card). This is the only 
way to delete a specific database that you are no longer using. A confirmation message pops 
up so that you can verify that you really want to delete the database. 

• Info – Shows more detailed information about the database, including the name and date of 
the desktop file that was used to generate it. Also note that the actual total size of the 
database in bytes is shown here as a decimal value. 

• Beam – This action lets you beam your database to another GedStar user if you both have 
devices with infrared ports. To do this, both units must be set up in the Palm Preferences 
application with Beam Receive set On. GedStar does not have to be active on the unit that 
will be receiving the database. It is only necessary to point the units at each other and start 
the beaming operation. A dialog will pop up on the receiving unit that asks if the database 
should be received. It will also display a warning if a database by the same name already 
exists on the device. When beaming is complete, the receiving unit will switch to the program 
launcher. If you then run GedStar, you should be able to go to the Database View and see 
the new database. Note: When the receiving unit displays the message “Accepting 
database,” it is actually doing a local operation that can take a long time for a large database; 
at this time, the actual beaming operation is finished and you just have to wait for the rest of 
the operation to complete. 
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Palm “Find” Command 
GedStar supports the standard Palm Find operation in a very powerful way that lets you search 
through almost all of the text that is in your database. To use this feature, you must first specify 
what type of data to search during a Find operation. Searching everything can be slow if there is 
a lot of data, and can also result in many more matches than you are looking for. To select the 
Find options, select Preferences from the Options menu in any view. The check boxes on this 
form specify if searches are to be done in any combination of names (main and alias); notes; 
places, including those in birth, death, christening, etc.; and dates. If you use your Palm for 
business purposes, you may want to normally turn off all of GedStar’s Find options so that you 
will not have to wait for it when you are searching your memos, to-do list, etc. 

After making your selection, you can do a normal Palm Find operation. It will work whether or not 
GedStar is running. For example, you could enter a search string such as “20 mar” and, if date 
searching is enabled, GedStar will find all people who have any sort of event that happened on 
the 20th of March! 

When you see a list of matches on the Find screen, tapping on one of them takes you to GedStar 
and directly to the selected person’s Detail view with the matching information shown. Note that 
the search text may appear more than once in a person’s record, but the Find operation can only 
take you to the first match that it finds. 

This Find feature can be a very powerful way to search for data in your database, and is even 
better than what many PC genealogy programs can offer. However, you have to be patient if you 
are searching through a very large database with all search options enabled! If the current 
database is on a removable memory card, then the Find feature is not supported due to the 
excessive time that it would take. 

Setting Preferences 
To set the preferences that affect various features of GedStar, 
bring up the menu bar in any view by tapping on the menu icon in 
the graffiti area. Select Options (if it is not already active), then 
tap on Preferences. The following are the settings in this dialog: 

• Descendants icon – Puts a small square icon next to a person’s 
name in various views if that person has descendants. Usually not 
used on color devices since color coding is available for that 
purpose. 

• Find options – Specifies the various fields in the database that can 
be searched by a PalmOS “Find” command. 

• On This Day options – Events to search for date matches when using this feature. 

Shortcut Bar 
If your device is running PalmOS 3.5 or later, there is a standard feature called a shortcut bar that 
comes up when you make the shortcut stroke in the graffiti area. This allows you to select a menu 
feature by tapping an icon rather than having to remember a shortcut letter. Depending on what 
view you are currently in, the following GedStar shortcut icons may appear: 

 

Go to Database Management View. 

 

 Export to memo. 
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Other Menu Commands 
There are several menu commands that are available in various 
views. The common commands that are specific to GedStar 
include: 

• Database Info – Shows some detailed information about the 
database that is currently being viewed. This includes the 
name and date of the GEDCOM file that was used to create 
the database. 

• Databases – Takes you to the Database Management 
View. 

• Colors – If you have a supported color device, this brings up 
a dialog box that lets you select colors to differentiate people in list views that have or do not 
have descendants in the database. Tapping on Change brings up a standard Palm dialog 
from which you can either select from a color palette or use RGB sliders to choose a color. 

Memory Card Usage Warning 
Although we have tried to handle most of the possible cases of accessing data correctly on a 
removable memory card, please remember not to remove the card while you are actively using 
GedStar with a database on the card. This is equivalent to removing a floppy disk from your PC 
while a program is reading or writing to it – definitely not recommended. GedStar will recognize 
this situation and try to recover from it, but it is possible that you will have to do a soft reset on 
your device. GedStar does scan for databases each time it is launched, so if you remove or 
switch memory cards before starting GedStar there will not be any problems. 
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Special Navigation Controls 
GedStar supports the following device-specific navigation controls: 

• The 5-way navigation control on the Palm Tungsten-T™ handheld. 
• The Jog Dial™ and back button on the Sony Clié™ line of handhelds. 

It is almost easier to just try it than to explain the operation, but this section might give you some 
information on the navigation that is not otherwise obvious. Using these controls, you can do a 
great deal of navigation within your database in a one-handed manner, without having to use the 
stylus. 

For purposes of the explanation, the following terminology will be used to refer to the ways that 
they navigation controls can be manipulated: 

• Up – Up button on 5-way, rotate Jog Dial upwards 
• Down – Down button on 5-way, rotate Jog Dial downwards 
• Left/Back – Left button on 5-way, back button on Jog Dial 
• Right – Right button on 5-way, no equivalent on Jog Dial 
• Select – Center button on 5-way, push in on Jog Dial 

There are also two modes that the navigation can be in. How the controls work is dependent on 
which mode is currently active. The modes are: 

• Normal mode – The default mode when entering a view 
• Select mode – The mode after initially pressing Select 

This is the action of the buttons when navigating in Normal Mode: 

 List View Family View Details View 

Up, Down Scrolls the list a page at 
a time. 

Scrolls the list of children 
a page at a time. 

Scrolls the text area a 
page at a time. 

Left or 
Back 

Goes back to previous 
view. 

Goes back to previous 
view. 

Goes back to previous 
view. 

Right Goes forward to next 
view. 

Goes forward to next 
view. 

Goes forward to next 
view. 

Select Switch to Select Mode. Switch to Select Mode Not used. 

 

When in Select Mode, you will see a highlighted name. The following are the actions (Select 
Mode is not applicable in the Details View): 

 List View Family View 

Up, Down Scroll one line at a time. 
Hold for rapid scroll. 

Scroll a line at a time, including the 
husband and wife. 

Left or Back Switch back to Normal 
View. 

Switch back to Normal View. 

Right Go to the Details View for 
the highlighted person. 

If on the husband or wife, go to the Family 
View for their next spouse, or go to the 
Details View if a child is highlighted. 

Select Go to the Family View for 
the highlighted person. 

Go to the Details View if the husband or 
wife is highlighted, or the Family View for a 
child. 
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• 

• 

• 

Error Messages 
We hope that you do not have any problems in using GedStar. However, if you do, then it is 
probably due to one of the following conditions (as noted in the Alert Box message): 

Database missing – GedStar could not find a compatible database. Use GPConvert or the 
conduit to create and load one or more databases. 

Old version databases deleted – During a database search, GedStar found some 
databases that are not supported by the current version of the PalmOS application and it 
deleted them. If this happens to a database that you have just downloaded, then you are 
probably using a conversion program from a different version of GedStar than the version 
that is loaded on your handheld device. Check your version numbers and reinstall software 
on your PC and/or handheld as necessary. Note that this message is normal if you have just 
upgraded to a new version of GedStar on your handheld and have not yet converted and 
downloaded your databases. 

Please Register  This is a friendly reminder that you can support the continued 
development of GedStar  perhaps with features that you suggest  by registering the 
program for a nominal fee. See our web site at http://www.gedstar.com for details on how to 
do this by online credit card purchase. The Register.pdf file in your GedStar directory tells 
you how to do this by mail. 

• 

• 

No match found for name search – The name(s) that you are searching for are not found in 
the database, or there are no more matches found. 

GedStar-Plus Upgrade Required – You have selected a database that was generated 
directly from a supported PC genealogy program using the GedStar-Plus converter, but you 
have not upgraded your copy of GedStar on your handheld to the Plus level. See our 
website at http://www.gedstar.com for instructions on upgrading for a nominal fee. 

• 

• 

• 

• 

Not enough free memory to continue – This indicates a severe memory shortage on your 
Palm device. It is likely that most other applications will also fail to run. You will have to delete 
some applications and/or databases before being able to do much. 

Fatal initialization error – There was an unexpected error when GedStar was trying to 
begin running. If your device appears to be OK otherwise, please contact us for technical 
support. 

No family record for individual – A person with no spouse or children does not actually 
have a family record even though they can have a family view screen. In this case it is not 
possible to export a family memo. To export information about the individual, go to their detail 
view and export from there. 

Error reading database file – This generally will only occur when a memory card is removed 
while GedStar is actively using a database on the card. Following this error, it is possible that 
you will have to do a soft reset on your device. In general, do not remove a memory card 
while GedStar is using a card-resident database! 

http://www.gedstar.com/
http://www.gedstar.com/
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